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Vuforia Engine 10.5 is Available!

The Vuforia Engine team is happy to announce our newest version. Below are the key updates in this
release. Please be sure to check out the release notes for the full list.
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License Manager Target Manager

License Manager

Create a license key for your application.

SENTSTRRELEE license BFE(IN FERY testLic), BEIRIEZEIA

Name Primary UUID Type Status v Date Modified

N/A Develop Active Aug 13, 2020

Please copy the license key below into your app

AYVZplH/////AARBMYTPwS9n5klelkvniXzBrOUEJKyNULJQAXhTKI6T JmO3Rull2HvIt 72nPXJEIBiKVY rkeadGZ
YAT1rEkDSDCEDfhwTMDFpADe ZW+nOSPX ) 7d3cNZ+cZBNEvy IVENpeScebpP1K7B] 10bHCSX3 60TBXYpVG90 i sET1F
Y1HQZ6£51RejHIUk3UTfre6zDS1sWS2a70CT7CMSDVSxgEHFQECiVZO0GE6T740ZBNEUWQy0SMz3kaB70yLOQ9GSRDI4N
+Je+nQG07SXp38s£6GL3cpG579NADQGIDKIWAVEV+/K++A+vJSKJ/rPHBazGi8gSvchMAS 6BEPSO82sjgdeM1T Tow
JRPnshozrphwwKcIl45/p/Cd
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License Manager = Target Manager

Use the Target Manager to create and manage databases and targets.

Search

Database Targets Date Modified

Create Database

Database Name *
myTest

Type:

O Cloud
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Target Manager > myTest

myTest Edit Name
Type: Device

Targets (0)

Add Target

[l Target Name

Add Target

O Target Name

0 ! IMAG2278

N Database, SAEELEE Add Target BDANEIEMR HEUAHES BIERISAIR.,

Type

Single Image

Rating (D

Rating @

L 8. 8.8 & ¢

Add Target

Type:

9 00U §

Single Image Cuboid Cylinder 3D Chject

Download Database (All}

Browse...

o .Jpg or .png (max file 2mb}
Status v Date Modified lpeor-ene

Width:

0.15

Enter the width of your target in scene units. The size of the target should be on the

Download Database (All) same scale as your augmented virtual content. Vuforia uses meters as the default
= unit scale. The target's height will be calculated when you upload your image.

Status v Date Modified Name:

IMAG2278

A N Aug 1 3' 202021:30 Mame must be unigue to a database. When a target is detected in your application,
this will be reported in the AP


https://www.gameislearning.url.tw/picture-resize.php
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TaiDataBase

SEEEE LB, $ARZ] Database AER(EANISGHEHIER, HBE52 Download Database A& Unity
Editor, BIRIE#HERHTERL unitypackage 18 NakEIZREN unity,

‘ Targets (3) ‘

Add Target Download Database (3)

Target Name Rating (© Status v Date Modified

3selected Delete

Single Image Aug 13, 2020 21:35
Single Image Aug 13,2020 21:35

Single Image Aug 13,2020 21:30

Download Database

3 of 3 active targets will be downloaded

Name:
myTest

Select a development platform:

() Android Studio, Xcode or Visual Studio
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Window > Package Manager LLJE«#%ZEU Vufor
2582 Import EITEN. FERERIAIHE Unity Editor 13

= Package Manager

+ - | Packages| My Assets]*

Vuforia AR Starter Kit

Sart: Mame - * | Filters = | Clear Filters | 8| = vuforia

o
ba
I
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Vuforia Engine

FTC

Version10.3.2 - November 15, 2021 ko)
VWiew In the Asset Store - Publisher Website < Publisher Support

Vuforia Core Samples

Vuforia Engine

See the Unity Getting Started
{https:/flibrary vuforia.comfgetting- started/getting-started-vuforia-engine-unity) guide to learn
more about working with Vuforia in Unity.

Maors...

All 3 packages shown Images & Videos -

Last update Jan 15, 17:03 C|- Import |
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File > Build Settings Z128 Player Setting, 4JiE XR Settings IEH A
Support (A& TE)EPR], EEF Project & EL—{E Resources 138
Support Installers PEGBIELLGNE NE) T, AEEHE unity E1T%E

L 1 |
Settings for PC, Mac & Linux Standalone Settings for PC, Mac & Linux Standalone e

Icon Icon

Resolution and Presentation Resaolution and Presentation

Splash Image Splash Image

Other Settings Other Settings

XR Settings XR Settings

Virtual Reality Supported || Virtual Reality Supported L

360 Stereo Capture (L) Vuforia Augmented Reality Supported & |
360 Stereo Capture L

MR Support Installers

Viuferia Augmented Reality
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developer portal

Unity 2020
EE—IE ﬂ t 7I:|:I: ‘R‘e‘l’ejsemi -Apply

Vuforia Engine 10.7

Use Vuforia Engine to build Augmented Reality Android, i0S, and UWP applications for mobile
devices and AR glasses. Apps can be built with Unity, Android Studio, Xcode, and Visual Studio.
Vuforia Engine can be easily imported into Unity by downloading and double-clicking the
.unitypackage below.

Add Vuforia Engine to a Unity Project or upgrade to the latest version

add-vuforia-package-10-7-2.unitypackage (222.89 MB)
MD5: 230a82b6e73b6d9318c8434a7e0d3edb

Download for Android
vuforia-sdk-android-10-7-2.zip (30.28 MB)
MD5: 140a414ebdc40c383993292824d9cf40

Download for iOS
vuforia-sdk-ios-10-7-2.zip (96.88 MB)
MD5: 9bd2000cfc174cc282b34661b2b55¢c3a

Download for UWP
vuforia-sdk-uwp-10-7-2.zip (25.97 MB)
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Develop

Active

Please copy the license key below into your app

Aug 13, 2020

® Inspecto 52 Na

@ Vuforia Configuration (Vufori nfiguration)

Global

Vuforia Version

rity. For more infermation refer to

App License Key AQtaulX//{{/AAABmeYbEJI4bEBsuDifMOdNWuSEUVIGZYmQr1
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Add License
Delayed Initialization
nera Focus Mode CONTINUOUS AUTOFOCUS

ional Foc nodes can be set using the CameraDevice.SetFo de() API, but are supported on all

Camera Device Mode MODE_DEFAULT
Max Simultaneous Tracked Images
Virtual Scene Scale Factor

e meter in the
N

Trained Targets Continuous Search

Share Recordings in iTunes

Databases

a Datab; | be automatically loaded and activated if its TrackingBehaviour is enabled ol

ARtest0514

Add Database

Disable model extraction from databases

Video Background
Enable video background v
Video Background Shader B Custom/VideoBackgr

Number Divisions 2
Asset Labels

AssetBundle None
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@ Inspector

@ v
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H# Scene @& Game
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Layer Default

A, Transform
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X1
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B v Image Target Behaviour (Scrip! @ -

From Database
ARtest0514
diait

Type

Database

Image Target
Add Target

Advanced

n v Default Observer Event Handle & -

ar

Consider target as visible if its status is:

Tracked or Extended Tracked
Use smooth transitio

Event(s) when target is found:

On Target Found ()

Listis Empty

Event(s) when target is lost:
On Target Lost ()

Listis Empty

B ~ Turn Off Behaviour (Script)
Assets

Editor

v Mesh Renderer

Materials
Lighting
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Receive Shadows v
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Icon Icon
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Splash Image Splash Image

Other Settings Other Settings
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Delete

Create Empty
3D Object >
2D Object >
Effects >
Light
Audie
Video
Ul
Vuforia Engine » AR Camera

Camera Image

Multi Image
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Cloud Image >

Maodel Targets b
J B console = Anim Camera Image >

Clear Collapse ClearonPlay Clear 3D Scan
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Q@ Inspector
«  ARCamera

Tag MainCamera ¥ Layer Default

A Transform
B~ Camera
i1 v AudioListener
« Vuforia Behaviour (Script)
World Center Mode DEVICE
Open Vuforia Engine configuration

0 Inspector z

6;, Vuforia Configuration {Vuforia Configuration @ 3t

Open

Global

Vuforia Version

mmeand de irs Lo ancrypt thair k
rity. For more ntormation refar to the
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Global
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B Inspector
2 ﬁj v ImageTarget
¥ Tag Untagged * Layer Default ¥j¥éﬁ%
; A

o Transform
v Image Target Behaviour (Script)

Type From Database
Database my_database
Image Target mankey_card

Add Target

Advanced
Width 0.095

Height 0.136831

A For axtendad tracking capabilities

DeviceTracker Settings
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Fi&VirtualButton

ImageTarget->Image Target Behaviour(Sc

O Inspector

s

@ v| ImageTarget | static™
- Tag Untagged * Layer Default -

e it ¢
20
Z 0
Z1

¥ /. Transform

X0
X0
X1

¥ 0
¥ 0
¥ 1

Position
Rotation
Scale

¥ | v Image Target Behaviour (Script) @ &

pgrade to Vuforia Engine 8.5.9 via Package Manage

Type Predefined -

Database multimedia_vuforia b

Image Target aslagodtonegg3bel-profile_ -
Add Target

¥ Advanced
Width 1
Height 1
Preserve Child Size

For extended tracking capabilities please use the
DevicaTracker.

DeviceTracker Settings

Restore Default Data Restore Defaults

Add Virtual Butten




| unitypasssERERESE)

IEIVHER
EimageTargetFiE—Ec#iIZ

p~ J| & N Account v J§ Layers v Jj Layout v

@ v ImageTarget Static *

& Tag Untagged * | Layer Default - -
v M Transform @ i i

Position X0 #o [Eo -

Rotation X0 e 0 =0

Scale X1 i1 Z1

» || ¥ Image Target Behaviour (Script) @
» # v Default Trackable Event Handler (Sc @
b x| ¥ Turn Off Behaviour (Script) Q@
» B v Mesh Renderer @
» Bl Image Target Mesh 13946 (MeshFil ® & :
( asiagodtonegg3bel-profile_image-0 @ 3+ &
Shader Unlit/Texture -

T+

T+

T+

T+

>

Add Component

imann 3

4 Search

MNew script




public class virtualButtonController : MonoBehaviour

{

1 reference

lic GameObject cube;

0 references

public virtualButtonBehaviour vb;

public float y = 3@;
~t is callec e the first frame update

rtualButtonBehaviour[] vbs = GetComponentsInChildren<VirtualButtonBehavi
for (int i = @; i < vbs.Length; i++){
vbs[i].RegisteronButtonPressed(OnButtonPressed);
vbs[i].RegisteronButtonReleased(OnButtonReleased);

1 reference

public void oOnButtonPressed(virtualButtonBehaviour vb){
print( vb.name + " %R ")
cube.transftorm.Rotate(@, y, @);

1 reference
public void OnButtonReleased(VirtualButtonBehaviour vb){
print( vb.name + " IEFHBIEE" );

er frame

PRAE 0 B 90 1T I 5% B 3 28 (2l = % ol
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HeEniZE 2

O Inspector

@ +| ImageTarget | Static~

Tag Untagged * Layer Default -

¥ /. Transform o 3+
Pasition X0 ¥ 0 =0
Rotation X0 ¥ 0 Z|0
Scale X1 ¥ 1 Z 1

++

» @ ~ Image Target Behaviour {Script) -]
» # + Default Trackable Event Handler (Sc @
» [ v Turn Off Behaviour (Script) -]
» B ~ Mesh Renderer (7]

» HH Image Target Mesh 13946 (Mesh Fil @

4

4

i

++

© v < SampleScene —
£ Directional Light ¥ # +« BtnTest (Script) @ 3+
@ ARCamera Seript " btnTest @
’ &jéjmf:ge;aw Cub > [ Cube ®
@mlitualﬂungn M —» = VirtualButton (VirtualButtonE &

|4
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O Inspector

ai

@ v ImageTarget
- Tag Untagged

Static =

Layer Default

¥ /. Transform

Position
Rotation
Scale

X0
X0
X1

e it
¥ 0 20
¥ 0 Z 0
¥ 1 Z1

¥ | v Image Target Behaviour (Script) @ 3
Jpgrade to Vuforia Engine 8.5.9 via Package Manage

Type
Database

Image Target

¥ Advanced
Width
Height
Preserve Child Size

DevicaTracker.

Predefined

multimedia_vuforia

aslagodtonegg3bel-profile_ -

Add Target

DeviceTracker Settings

Restare Default Data

For extended tracking capabilities please use the

Restore Defaults

Add Virtual Butten
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Fhidtag

e

) _~ VirtualButton ~ Static~
1 129[Untagged ~ || Layer Default -
@ 3t
Z 0.2198

Z\0
Z0.284405¢

¥ [ v Virtual Button Behaviour (Script) o
Upgrade to Vuforia Engine 8.5.9 via Pac kag& Ma nager

Transform

X10.3381 Y 0.001
X0 YO0
X 0.284405: ¥ 1

@ +  VirtualButton

Tag | Untagged v ] Layer
T v Untagged

Name |vb
Sensitivity Setting HIGH

Respawn Y 0
o Finish Y0
e EditorOnly Y1
e = Nl’tﬂinCﬂmerﬂ |
P o 1
i ayer P
L= GameController E_
Mame anbtn
Sensitivi btn =
¥ 6] v
.
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EpiVirtualButton®a= b
EYFEVirtual Button Behaviourfscript9ifs] EFEARZEENGameObjectiyE =

TFVMMMMIMH 9 3
Upgrade to Vuforia Engine 8.5.9 via Package Manager

Name vb
Sensitivity Setting HIGH :

& = = —_ i
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C VB2controller.cs @

Assets > € VB2controller.cs > 4 VB2controller
System.Collections;
System.Collections.Generic;

using UnityEngine;
using Vuforia;

0 references
public class VB2controller : MonoBehaviour

2 references

public GameObject cube;

0 references

public VirtualButtonBehaviour vb;
0 references

public float y = 30;

1 reference

public float x = 30;

// Start is called before the first frame update
0 references

void Start()

{
cube = GameObject.Find("Cube™); A T N ) Al | = iy | E ~—
VirtualButtonBehaviour[] vbs = GetComponentsInChildren<VirtualButtonBehaviour>(); }\jQ %EE It E:ﬁ gé $j:l, ’f—_]_ HT_]' o E E 7%% 'ﬂE EIE.E }}E }§ ﬁﬂ
for(int i = @; i < vbs.Length; i++) {
vbs[i].RegisterOnButtonPressed(OnButtonPressed);

vbs[i].RegisterOnButtonReleased(OnButtonReleased);

}

e | 5l 2 WDl ¥22 51 A o 55 M EL fth 60 L 25 BRAVEN 1

public void OnButtonPressed(VirtualButtonBehaviour vb) {
print(vb.name + f )

if (vb.gameObject.CompareTag("VB2") == true) { El
cube.transform.Rotate(x,@,0); $‘—r %tl X$Hﬂ

¥
}

1 reference
public void OnButtonReleased(VirtualButtonBehaviour vb) {
print (vb.name + ° il
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- Tag Untagged *  Layer Default -

Av Transform e it
Paosition X0 YO0 =0
Rotation A0 YO Z0
Scale X1 ¥ 1 Z 1
~ Image Target Behaviour (Script) @ 3+
# + Default Trackable Event Handler (Script) e
~ Turn Off Behaviour (Script) o
B ~ Mesh Renderer @ 3+
H  Image Target Mesh 13946 (Mesh Filter) e
# + BtnTest (Script) o
amp Script ¢ btnTest &
Cub 0 Cube &
(7] Directional Light o . .
Ej ARCamera Vb o VirtualButton (VirtualButtonBehaviour &
¥ |# + Btnan (Script) 9
Seript ¢ btnan =
{1 VirtualButton = Cube (Animator) ®

.S
o

E'j WirtualButten_an » [ \irtualButton_an (VirtualButtonBehavi &




Unity 35 E1F (EiEizEH)

(g 01i=2\ih, =% /mMlElEE/btn01{2pX

Husing System.Collections;
using System.Collections.Generic;
using UnityEngine;
using Vuforia;

Hpublic class btnTest : MonoBehaviour,IVirtualButtonEventHandler
{

=] Cho L s L b e

()

public GameObject cub;
public VirtualButtonBehaviour vb;
public float y=30;//vEiFeEE(E - T EHELL

=]

void Start()

{
VirtualButtonBehaviour[] vbs = GetComponentsInChildren<VirtualButtonBehaviour>();
. for (int 1 = 0; 1 < vbs.Length; i44+) { vbs[i].RegisterEventHandlerithis); }
}
public void OnButtonPressed(VirtualButtonBehaviour vb)

{
if (vb.gameObject.CompareTag{ "btn") = true) ‘;I-iul':'ju%uﬂﬁ{@?ﬁﬁﬂpj%%ﬁﬁ%ﬁ1ﬂﬁﬁﬁ Z

cub. transform.Rotate(0, v, 0);

}

public void OnButtonReleased(VirtualButtonBshaviour vh)

{
}
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Haruko motion01

-

Assets » Haruko > Animations

» U# Haruko@idle

» §# Haruko@jump
» U# Haruko@kick_attack

» §# Haruko@run
r : =113

Ta Haruko_motionD3
e Haruko_motion04
Ta Haruko_motion05s
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¥ Haruko@idle

» §# Haruko@jump
» # Haruko@kick_attack

» §# Haruko@run
» G Haruko@walk
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#&17GameObject->Ul-> canvas, ifi{§Render Mode )

GameObject Component Window Help
[ Create Empty Ctrl+Shift+MN

Create Empty Child Alt+Shift+M ine acka P i v ®m « Canvas 8 3+ :
30 Object > 4 MIEIEEICAET Render Mode World Space - | EZAkworld space
20 Otysct * Event Camera None (Camera)
Effects
i ‘ A Warld Space Canvas with no specified Event Camara
Light ‘ may not register Ul evenls correctly.

Audio

Video Sorting Layer Default -
1] Text Order in Layer 0
Vuforia Engine » Text - TextiMeshPro Arir Alela Sharer Cha Nothina 57

Camera Image

Raw Image

Button
Button - TextMeshPro
Toggle
Ctrl+= Slider

Set as last sibling Ctrl+- Serollbar

Move To View Ctrl+Alt+F Dropdown

Align With View Ctrl+Shift+F Dropdown - TextMeshPro
Align View to Selected Input Field

cggle Active State Alt+Shift+A Input Field - TexthMeshPro

Canvas
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Scroll View

Event System
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Haruko

Assets » Haruko > Animations
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f you want to enable ARCaore support for the Vuforia Engine, please follow the steps outlined in the library artic
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using System.Collections;
using System.Collections.Generic;
using UnityEngine;

—ipublic class modelbtn : MonoBehaviour
{
. public Animator anm;
public void run() By —(EWENHENE ZHIz5A0f
{

an.SetTrigger( " run");

}
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C¢ UlButtonController.cs X

Assets > € UlButtonController.cs > 43 UlButtonController > & attack()
1 using System.Collections;
using System.Collections.Generic;
using UnityEngine;
using UnityEngine.UI;

0 references
public class UIButtonController : MonoBehaviour
{
// Start is called before the first frame update
3 references
public Animator an;
0 references
public void run()
11 {
12 an.SetTrigger("run”);
13
14
0 references
15 public void jump()
16 {
17 an.SetTrigger(“jump");
18
19

0 references
20 public void attack()

21 {

2 °* ‘ an.SetTrigger("attack™);
23 }

24}

25
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Vuforia A48 - SREAPHER

" ontent.php?getb=39&fo0g=9997
Vuforia 222 unity AR ZERI2(AUr ‘

t.ohp?getb=7&foog=9997
VuforiaE#%ZEH(Virtual Button) — ARE ]S
)?2getb=9&foog=9997

Virtual buttons in AR with Vuforia in Unity



https://www.gameislearning.url.tw/article_content.php?getb=39&foog=9997
https://www.gameislearning.url.tw/article_content.php?getb=7&foog=9997
https://www.gameislearning.url.tw/article_content.php?getb=9&foog=9997
https://www.youtube.com/watch?v=Ckw4RKKVE3k
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BERIE

Window->Animation->Animation, Al &)t

B - PC, Mac & Linux Standalone - Unity 2019.4_28f1 Personal* <DX11>
Window Help

bivi Windows

Ctrl+Tab
Ctrl+Shift+Tab

Next Window

0 & |~

Previous Window

Layouts

Vuforia Configuration Ctrl+Shift+V

Asset Store Ctrl+9

Package Manager

Asset Management

TexthMeshPro »

General »

Rendering »

Animation Ctrl+6
Audio > Animator

Sequencing » Animator Parameter
Analysis

Dopesheet Curves

To begin animating VirtualButton_an, create an Animator and an Animation Clip.
Create
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